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Installation
To install Webster's Frogs of Australia, please follow these instructions:

(i) Turn on your computer and start up the Microsoft Windows operating environment.

(ii) Insert the Webster's Frogs of Australia CD-ROM into your CD-ROM drive.

(iii) Choose the Run command from the File menu in the Windows Program Manager. (If you are new
to using the mouse, simply click on the File name in the menu bar at the top of the Program Manager
screen, and then click on the Run command from the list of commands that drops down.)

(iv) In the dialog box that then appears, key in the following - x:\setup, where "x" refers to the drive 
letter for your CD-ROM drive (quite often, this is "D").

(v) Follow the instructions on the screen.

(vi) The installation program will create a program group and icons in your Program Manager.



Starting and Exiting the Program
For Users of Windows 95 or higher

This CD is AutoRun enabled, which means that as you insert the CD into your CD player, a program 
is automatically run, allowing you to perform an installation of the program, or run the program.

Alternatively, if you have installed the program, use the Start button to locate the Webster Multimedia
Products group, and the program icon marked Webster's Frogs of Australia.

Once the program has started, you can exit the program using the Exit command, from the Tools 
menu.

For Users of Windows 3.1, Windows 3.11, Windows for Workgroups.

To start Webster's Frogs of Australia, first ensure that you have inserted the CD-ROM into your CD-
ROM drive.

Locate the Program Group called Webster Multimedia Products in your Program Manager, and 
double-click on the icon marked Webster's Frogs of Australia.

Once the program has started, you can exit the program using the Exit command, from the Tools 
menu.



Startup Options
There are several startup parameters that can be used in conjunction with this product to alter 
slightly either its features, or the methods it uses to perform certain features.

A command line parameter is an extra bit of information you add to the startup line of a program. To 
use a command line parameter, you must use the Run command (from either the Program Manager, 
or the File Manager), (or the Start button menu for users of Windows 95) or use the Properties 
command from the Program Manager to permanently affix these parameters.

The available command line parameters are as follows:

/noprint

Using this command line parameter will prevent any printing from taking place from within this 
program.

/nostart

This parameter will start the program, bypassing the very first startup screen.



Startup Screen
Now that you have started Webster's Snakes of Australia, you will see the startup screen appear as 
shown here.

In this screen, you can choose any of the following options by clicking on them once with your 
mouse:

Introductory Video

Select this option to view a video, introducing you to this CD-ROM, and allowing you to find out a 
little more about what you will find out!

Webster Publishing

Select this option to view a video, introducing you to Webster Publishing.

Tutorial

Select this option to start the tutorial - a guide on how this CD works, and what you might expect to 
find.

Get Started:

Select this option to move directly to the Contents!



The Contents
The Contents screen allows you to move around this product - select new chapters and sections.

There are several ways that you can make this Contents dialog box appear. If you have just started 
the product, you can select the 'See Contents' option from the Startup Screen.

You can also select the 'Contents' button from the Toolbar.

Selecting Chapters or Sections

To select a chapter, click on the chapter you would like to view. If that chapter contains no sections, 
you will move directly to page one of that chapter.

If that chapter contains more than one section, a popup menu will appear listing all sections. You can
select a section from this popup menu as though it were a normal command, and you will move 
directly to page one of that section.



Screen Description
Let's go over some of the features of a standard page, and how they can be used.

If you read no more, read this - you can navigate through this product using only the buttons in the 
Toolbar. Note that you can move to the 'Next Page', or 'First Page', or 'End' of a section. To view a 
new section, select the 'Contents' button.

Note: Depending on the Toolbar settings, which are accessed using the Options button, or the
Options command in the Tools menu, your Toolbar may either contain captions, or just icons. 
If your buttons contain just icons, you can move the mouse over these buttons to view the 
caption of that button. Alternately, use the Options command to set the Toolbar to also 
display captions (the 'Toolbar with Pics/Text' option).

Title Bar

The Title Bar appears across the top of the screen, and displays the title of the program running. On 
the right hand side of the Title Bar are the maximize and minimize buttons.

Menu Bar

The Menu Bar appears just below the Title Bar, and displays the list of menus that you can select 
from.

Toolbar

Below the Menu Bar is the Toolbar, which contains 12 different buttons. You can perform most normal
operations on the CD-ROM using these buttons. A brief description of each button can be found in 
the Toolbar section of this help file.

The Text Box

The text box (or window) is where you read the text of the book. You can do various things with this 
text box:

(i) You can change its position on the screen by holding the mouse button down in its title bar and 
moving the mouse around. 

(ii) You can change its size by holding the mouse down on any side of the window, until it changes to 
a horizontal or vertical dual arrow, and then moving the mouse in or out to either reduce or enlarge 
the window.

(iii) You can hide the text box by clicking on the 'Hide Text' button in the Toolbar as described in the 
Toolbar section. If you hide the box in this fashion, you can display it again by clicking on the 'Show 
Text' button in the Toolbar. You can also hide the text box by double-clicking on the text box control 
menu box (the small box at the left end of the text box title bar).

Status Bar

The Status Bar, below the Menu Bar, provides information on the following:

* Chapter name (left-hand side)



* Section name (right-hand side)
* Page name (middle of Status Bar)



Setting Options
The Options dialog box, pictured below, is accessed by clicking on the 'Options' button from the 
Toolbar, or the 'Options' command in the 'Tools' menu.

This dialog box is used to set quite a number of user preferences. You simply select the options you 
wish to set, and then click on the OK button. All these options will remain set the next time you start 
this program.

Change Font

When you select this button, you can select a new text font, size, and style for the main text box.

Text Colour

When you select a colour from this list, the main text associated with every page will display using 
this colour.

Heading Color

When you select a colour from this list, the heading associated with every page will display using this
colour.

Popup Color

When you select a colour from this list, any popups (i.e glossary entries) that appear in the text will 
display using this colour.

Jump Color

When you select a colour from this list, any jumps (i.e hypertext links) that appear in the text will 
display using this colour.

Background

When you select a colour from this list, the background of the main text will display using this colour.

Automatically Play Movie

When you move to a new page, and a movie is associated with this page, this option will determine 
whether that video starts playing automatically, or waits for you to play the video, if you wish, using 
the 'Play Video' button in the Toolbar.

Play Movie at Normal Size

This option ensures that movies play at the size at which they were originally created.

Play Movie at Smaller Size

If you are having trouble playing videos at the normal, or larger sizes, selecting this option can often 



help improvide performance. Our videos are quite large to begin with, so selecting this option does 
not make too much of a difference.

Play Movie at Larger Size

If you have a very fast system, you could try playing movies at this size - it increases video area by 
about 20%, but can affect video performance on slower systems.

Play Movie at Full Screen

This option forces the video to play at full screen size - a little blocky, however, good from a distance.
Videos will play more smoothly at this stage.

800 x 600 Pictures

Most pictures provided within this book are provided at a set size. However, you can select this 
option to scale each picture at around 20% above its design size. This may make the program look a
little more attractive on a larger, or high resolution screen.

Optimise for 16 Colour Display

This option is only available if you are running Windows in 16 colors, which is generally not enough 
to display photographs very easily. When you select this option, photographs will take longer to 
display, but they will be dithered so that they look more reasonable.

Default Brightness

Normally, pictures are displayed with no brightness adjustments. However, if you set this option to a 
figure above 5, pictures will be brightened as they are loaded, and a figure below 5 causes pictures 
to be darkened as they are loaded. This lets you adjust pictures based on your monitor.

Automatically Play Sound

 When you move to a new page, and a sound is associated with this page, this option will determine 
whether that sound starts playing automatically, or waits for you to play the sound, if you wish, using 
the 'Play Sound' button in the Toolbar.

Do Not Show Toolbar

This option, when selected, ensures that the Toolbar is hidden from the screen. You can achieve 
most functions in the Toolbar using menu commands.

Toolbar with Pictures/Text

This option, when selected, displays the Toolbar with pictures and text in the toolbar

Toolbar With Pictures Only

This option, when selected, displays the Toolbar with pictures in the buttons, but no caption. A small 
bar will appear whenever a mouse is moved over a button to indicate what that button is used for.



No Background Bitmap

If this option is checked, the background bitmap is removed from the program window. This results in
a plainer looking window, but can help to reduce memory overheads if you are having memory 
problems.

No Background Sound

If this option is checked, no background sound will play on the Introduction or Contents screens.

Alter File Locations

This button provides access to advanced options - options you should never have to use (these 
options are explained below). Normally, these options will remain as they are, but if you change the 
drive letter indentifying your CD-ROM, you may need to adjust these settings.

Pictures Directory

This is the directory this program searches for its picture files.

Sound Directory

This is the directory this program searches for its sound files.

Movie Directory

This is the directory this program searches for its movie files.



Classification Trees
This command is available from the Interaction menu. The dialog box that appears when you select 
this command displays either the entire classification tree for snakes.

This dialog box displays a heirarchical tree, indicating the relationships between various frogs.

If you select this dialog box when you are viewing a page from the CD, the part of this tree most 
closely related to that page will be automatically selected. For example, if you are viewing a certain 
frog, that frog will be automatically selected as this dialog box appears.

You can double-click on any Class, Order, Suborder, Genus, Subgenus, or Group to expand or 
collapse all entries subordinate to that entry. In the same fashion, you can use the commands in the 
Tools menu to automatically hide or show certain sections of this map.

Help

This button activates this Help program.

Close

This button will close this dialog box.

Go To Selected Section

This button will take you to the page most closely represented by the selection you have made in the 
tree.

Print

This option will allow you to print only those branches of the tree that are currently visible.

Search

This option allows you to search for any text that may occur within this tree, highlighting the next 
occurance of that text (the search starts one line lower than the line currently selected).

Search Again

If you have previously searched for some text as described above, this button becomes enabled. 
Selecting this button will highlight the next occurance of the word last searched for.



Search
The Search dialog box is accessed by clicking on the 'Search' button from the Toolbar.

You use this dialog box to locate a specific item - this may be a word or phrase, user highlights, 
topics, and much, much more

This dialog box is a rollup - note the two buttons at the top right-hand corner of the dialog 
box. The right-hand button will allow you to alternately rool up, and unroll the dialog box - 
shrinking it, but not removing it from the screen. The button just to the left of this button, with
the cross in it, will hide this dialog box.

The Buttons

Across the top of the dialog box are a series of buttons that allow you to select what you are 
searching for.

Word

Select this button if you would like to search the text for a specific word, phrase, or part of a word. 
When you click on this button, the Word Search dialolog box will appear.

Page

Selecting this button will fill the Page List with a list of every page (i.e. every page) contained in the 
book in alphabetical order.

Frogs

This button will create a list, in alphabetical order, of every frog covered in this CD-ROM. You will 
have the option to display snake names in common, or Latin format.

Custom...

This option will lead you to the section called Custom Search. The dialog box that appears here will 
allow you to search for a snake that match a certain criteria.

User Note

Selecting this button will fill the Page List with a list of every page in the book to which you have 
added a User Note.

Highlight

Selecting this button will fill the Page List with a list of every page in the book to which you have 
added a Highlight.

Video

Selecting this button will fill the Page List with a list of every video contained in the book.



Search:

This option determines where any search (of the options listed above) takes place. Your choices are 
'Entire Book', This Chapter', This Section', and This Page'. When This Page' is selected, you can only
use the 'Word' search option.

Page List

Ultimately, the contents of this list are a list of pages that meet the search criteria selected from 
above. You can view any page in this list by double-clicking on the page name, or selecting a page 
from the list, and clicking on the 'Go To Selection' button, below.

Go To Selection

See 'Page List', above.

Stop Search

When you are searching for a word or phrase, this will take a little longer than the other searches. 
For this reason, while a search is being performed for a word or phrase, the 'Close' button will be 
renamed to the 'Stop Search' button. Clicking on this button will halt the search. Also, if you attempt 
to move to a page while a search is being carried out, the search is halted, and you are moved to the
selected page.

If you elected to search for a word or phrase, and the 'Page List' contains the names of pages that 
contain that word or phrase, you may see the word or phrase highlighted in red, and underlined, as 
you move to that page using the Page List', or 'Go To Selectioni' button.



Search by Photograph
The Search for Animal by Photograph command, found in the Interaction menu, will cause this dialog
box to appear.

From this dialog box, you can view all frogs for which there is a picture. Use the scroll bar, on the 
right hand side of the pictures to change the pictures displayed.

Below each picture is the name of the frog pictured. You can select any frog by clicking on it. Double-
clicking on a frog, or clicking once, and then on the Go To Selection button, will move you directly to 
that snake in the CD.



Search by Distribution Map
The Search for Animal by Distribution Map command, found in the Interaction menu, will cause this 
dialog box to appear. A distribution map marks the areas in Australia where this frog is generally 
found.

From this dialog box, you can view all frogs for which there is a distribution map. Use the scroll bar, 
on the right hand side of the pictures to change the pictures displayed.

Below each picture is the name of the frog whose distribution map is pictured. You can select any 
frog by clicking on it. Double-clicking on a frog, or clicking once, and then on the Go To Selection 
button, will move you directly to that snake in the CD.



Highlighting Text
The 'Highlighter Pen' dialog box appears when you select the 'Highlighter Pen' command from the 
'Tools' menu.

Highlighting text using this dialog box is almost exactly the same as using a highlighter pen in a 
normal book, only more flexible. The easy way to use this technique is to select the text you would 
like to highlight (on the left of this dialog box) in the same way that you select text in a word 
processor. Then select a 'Highlight Color', and select the 'Highlight Text' button. You can then click on
OK - the text you highlighted will be highlighted on the screen in the colour you selected, every time 
you come back to this page. To stop this from happening, you can select the 'Remove Highlights' 
button, or deselect the 'Always Display User Highlights' option.

Select Text to Highlight

In this section is displayed the text as it appears on the main screen. Highlight the text as you 
normally would in a word processor. This is the first step in highlighting text.

Highlight Color

In this list box, select the colour that you would like the currently selected text to be highlighted in.

Color Description

This section allows you to define what each colour means to you. You can edit this text, and if you 
wish, make this description different for every colour. This means that you may highlight different text 
in different colours, and this description will remind you why you highlighted text in each particular 
colour. These settings will remain even when you shut down this program.

Preview

This section displays the text and highlights as they will appear on the current page.

Highlight Text

This button applies the current highlight to the currently selected text, in the currently selected 
'Highlight Color'. The 'Preview' will display the result.

Remove Highlights

This button removes all highlights from the current page.

Always Display User Highlights

If this option is checked, it ensures that all highlights are applied to the text. When this option is 
deselected, all user added highlights are ignored.



Creating and Loading Libraries
Creating a Library is a very flexible way of grouping together normally unrelated pages, or pages that
interest you, and locating them again very easily. The theory is quite simple.

To display the Library dialog box, you select the 'Create/Load Library' command from the 'Tools' 
menu. When this dialog box is on the screen, you can still move around the book - to other pages, 
other chapters, whatever. Whenever you find a page you would like to add to your library, select the 
'Add Current Page to Library' button. The name of the current page is added to the 'Library List'.

Once you have created your library, you can save it to disk, using the 'Save Library' command in the 
'File' menu, and open it at a later stage using the 'Open Library' command.

This dialog box is a rollup - note the two buttons at the top right-hand corner of the dialog 
box. The right-hand button will allow you to alternately rool up, and unroll the dialog box - 
shrinking it, but not removing it from the screen. The button just to the left of this button, with
the cross in it, will hide this dialog box.

Library List

This list contains a list of pages in the current library. Double-clicking on any page in this list will take 
you directly to that page.

Add Current Page to Library

When you select this option, the currently displayed page is added to the 'Library List'. If a page in 
the 'Library List' is currently selected, the new page is added before that page.

Save Library...

This button saves your library file to disk. You can store library files anywhere on disk.

Open Library...

This button allows you to open an existing slide show file. All the pages in that file will appear in the 
Library List'.

New Library

This button clears the current library file and Library List.

Remove Selected Page

When you select this button, the currently selected page in the 'Library List' is removed from the 
library.

Preview Selected Page

When you select this button you will move immediately to the page currently selected in the 'Library 
List'. This is the same as double-clicking on the Library List.



Play Slide Show

This button plays your pages in a slide show - one after the other, changing pages automatically. 
While this slide show is playing, this dialog box disappears. The slide show is halted whenever 
another button is used, or the Esc key is pressed.



Adding Notes
If you are using this book for research or educational purposes, you may wish to take notes as you 
move through the different chapters. To do so, you can use the 'Add Note' button from the Toolbar.

When you add notes to a page, the text of that note is saved automatically as you move on. If you 
ever return to this page, you can again view or edit the note you attached to that page, by selecting 
the Add Note button once more.

When you return to a page that has had a note added to it, a button with a paper clip icon appears in 
the bottom left-hand corner of the screen. Clicking on this button will reveal the note on this page.

You can print User Notes, as described in Printing.

You can copy User Notes to the Clipboard, as described in the Copy User Note to Clipboard 
command.

You can search for User Notes, as described in the Search Dialog Box.



Bookmarking
Create Bookmark
Go To Bookmark



Create Bookmark
The 'Create Bookmark' dialog box allows you mark a page, using any name you like, so that you can 
return to this page very quickly at any later stage.

This dialog box will appear after selecting the 'Create Bookmark' command from the 'Bookmarks' 
menu.

Create Bookmark

In this text box, insert the name that you want to identify with the current page.

When you have created a bookmark in this fashion, you will find that the bookmark name will appear 
at the bottom of the 'Bookmarks' menu, so that you can move directly to the page by selecting a 
command from this menu.

All bookmarks are saved to the local hard disk, so they will remain when you quit and restart the 
program.

To delete a bookmark, you must use options found in the 'Go To Bookmark' dialog box.



Go To Bookmark
The 'Go To Bookmark' dialog box allows you to select a bookmark that you, or another user on your 
machine has created (using the 'Create Bookmark' command), so you can move to the page 
identified by that bookmark quickly.

Select Bookmark

In this list are the bookmarks currently defined for this book. If this list is empty, no bookmarks have 
been created. Bookmarks are created using the 'Create Bookmark' command.

Go To Selection

Once you have selected a bookmark from the 'Select Bookmark' list, this button will take you to that 
page. The same effect can be achieved by double-clicking on a bookmark name in the 'Select 
Bookmark' list.

Delete

Once you have selected a bookmark from the 'Select Bookmark' list, this button will delete that 
bookmark (not that page!).



Clipboard Support
Copying Text
Copying Photographs
Copying a Movie or Animation Frame
Copying User Notes



Copying Text
You may copy text contained within the text window on any page to the Clipboard, and into your word
processor.

To do this, you choose the 'Copy Text to Clipboard' command from the 'Edit' menu to activate the 
'Copy Text' dialog box. This dialog box initially highlights all text in the text box on the current page. 
You may modify this selection if you wish, and then click on the 'Copy' command.



Copying Photographs
Whenever a photograph appears on the screen, selecting the 'Copy Picture to Clipboard' command 
will copy this object to the Clipboard.



Copying a Movie or Animation Frame
When a movie or animation is displayed on the current page, and you wish to copy it to the 
Clipboard, make sure you stop the movie from playing (using the 'Stop Video' button in the Toolbar).

Use the small vertical control bar under the Toolbar to position the movie at the frame you would like 
to copy to the Clipboard. Select the 'Copy Picture to Clipboard' command, which copies the current 
movie frame to the Clipboard.

Depending on what the object is being copied, it may be copied to the clipboard as a DIB, or a BMP. 
Most applications accept DIBS quite happily (Paintbrush being an exception). Some programs, 
however (such as Write) seem to have problems with BMPS. Most word processing applications, or 
desktop publishing applications will accept both quite happily - however, you may to have to use the 
Paste Special command from an application, if nothing 'appears' to be in the clipboard.



Copying User Notes
You can copy any User Note to the Clipboard by selecting the Copy User Note to Clipboard 
command from the Edit menu.

Assuming there is a User Note on the current page, the text of this user note is then copied to the 
Clipboard. No dialog box will appear as this happens.



Go To Page
This dialog box appears after selecting the 'Go To Page' command from the 'Pages' menu. The 'Go 
To Page' dialog box allows you to select, and move to, any other page in this section. To move to a 
page in another section, you must use the Contents screen.

Required Page #:

In this text box, you can enter the number of the page you wish to move to. This page number in the 
list will be selected automatically.

Select a Page

In this list are the names and page numbers of every page in the current section. The page you are 
currently on will be highlighted. If you double-click on a page in this list, you will go directly to that 
page.

Go To Selection

Once you have selected a page from the 'Select a Page' list, this button will take you to that page. 
The same effect can be achieved by double-clicking on a page name in the 'Select a Page' list.



Page History
The 'History' dialog box allows you to select, and move to, any page in the book that you have 
already been to in the current session. Keep in mind, however, that the 'Pages' menu contains the 
name of the last ten pages you visited, allowing you to return to these pages by selecting the menu 
command.

This dialog box will appear when you select the 'History' command, from the 'Pages' menu.

Select a Page

In this list are the names of every page that you have looked at in the current session. If you double-
click on a page in this list, you will go directly to that page.

Go To Selection

Once you have selected a page from the 'Select a Page' list, this button will take you to that page. 
The same effect can be achieved by double-clicking on a page name in the 'Select a Page' list.



Printing
This dialog box appears when you select the 'Print' button, from the Toolbar, or the 'Print' command 
from the 'Tools' menu.

This dialog box controls the printing of pages from this book. You select what you would like to print 
from the 'Pages' section, and then what part of each page you would like to print using the 'Options'. 
Selecting the 'Print' button starts printing. Once you start printing, you can be cancel by pressing the 
'Esc' key.

Print Current Page

If you select this option, only the current page will print.

Print Entire Section

If you select this option, all pages in the current section will print. Although the 'From' and 'To' text 
boxes will be inactive, they will display the range of pages that will print.

Print Selected Pages

If you select this option, you can edit the 'From' and 'To' text boxes to set a start and an end page.

Print Book Contents

If you select this option, a list of chapters, and sections within each chapter, will print.

Print Only Pictures

Make sure you select this option if you do not want to print the text on each page - just the pictures. 
Only one page will appear on each printed page.

Print Large Pictures

If you select this option, the picture on each page will print as large as possible as will fit on a page 
(after the text on that page has printed). Only one page will appear on each printed page.

Print Smaller Pictures

If you select this option, the picture on each page prints at the top right of each page, at a size of 
around 3 inches x 3 inches. Using this option, you can also fit several pages to the printed page 
(assuming they fit).

Do Not Include Pictures

If you select this option, no pictures are printed. Using this option, you can also fit several pages to 
the printed page (assuming they fit).

Include User Notes



This option will force a User Note on each page, if it exists, to print along with the other information 
on that page.

Include See Also References

This option will force Hypertext Links on each page, if they exist, to print along with the other 
information on that page.

Include Date and Time

This option will force the current system time and date to print with each page number.

Select Printer Font

This button allows you to select the font you would like your printer to use when printing from this 
book.

Select Printer

This button allows you to select the printer you would like to print to, as well as set printer options.

Print

This button starts the printing process. After printing, you will return to the page you were previously 
on.



Linking With Other Applications
This dialog box is merely a quick way of opening your word processor or similar application. Before 
this dialog box appears, several major applications are searched for, and may appear in this list. You 
can select any program from this list and start it from here.

Select Your Application

From this list, you can select any word processor, graphics, or presentation program that appears. 
Double-clicking on any program name will start that program.

Open Selected Program

This button has the same effect as double-clicking on the above list - the selected program will open.



Image Manipulation
It is possible to enhance or alter the appearance of the photographs that appear on the screen. To do
this, you use the 'Image Manipulation' command, found in the 'Interaction menu'. You can only 
activate this command when a photograph appears on the current page.

There are several other ways in which you can enhance an image - these are covered below.

Gamma, Brightness, Contrast, Sharpen, and Soften

Adjust the Gamma, Brightness, Contrast, Sharpen, and Soften controls from 1 to 10, and click on the
Apply button to preview how these commands affect the picture.

Rotate, Vertical Mirror, Horizontal Mirror, and Negative Image

The Rotate option ranges from -360 to 360, and will rotate the picture on the screen. The Vertical 
Mirror, Horizontal Mirror, and Negative Image commands are fairly self-explanatory.

Any effect you apply will be removed if you use the Cancel button to exit this dialog box.

Any effect you apply is only temporary - it will be removed whenever you move to the next page.

Zooming in on a Photograph

If you hold down the Shift key, and click on a photograph with the left mouse button, you can zoom in
on the photograph (at the position of the mouse) a little at a time. Pressing the 'Esc' key, or selecting 
the 'Restore Picture' command from the 'Interaction' menu will return the picture to normal.

Drawing on a Photograph

When you double-click on a photograph, or select the 'Full Screen' button from the Toolbar, the 
photograph displays at full screen. When in this mode, you can use the left mouse button to draw 
over the graphic - to annotate it, highlight sections - whatever you like.

In addition to this, if you hold down the right mouse button, you can select the 'Editing Tools' 
command from a popup menu, which displays the 'Editing Tools' rollup. From here, you can select a 
new colour or line thickness for drawing over the picture.

Any changes you make to a picture are purely temporary - they disappear as soon as you return 
from full screen mode (by pressing the 'Esc' key).



Related Topics
On many pages, there may be a series of related topics containing information relevant to the current
topic. These will be denoted by a bar that runs across the bottom of the text box, reading 'Click and 
Hold Here for Related Topics'.

When you click and hold the mouse button down on this bar, a popup menu with a list of page names
will appear. Any page name you release the mouse button on will send you directly to that page.



Working With Video and Sound
When a page contains a video, or some sound, you can choose whether this video and/or sound 
starts playing as soon as you view that page. This is controlled using the Options command.

When a video is playing, a button in the Toolbar will read 'Pause Video'. Clicking on this button will do
just that - pause the video. As soon as you pause the video, this button will read 'Play Video'. It will 
also read 'Play Video' when the movie has finished or has not even started. Clicking on this button at 
this stage will start or resume the video playing.

When a sound is playing, a button in the Toolbar will read 'Pause Sound'. Clicking on this button will 
do just that - pause the sound. As soon as you pause the sound, this button will read 'Play Sound'. It 
will also read 'Play Sound' when sound has finished or has not even started. Clicking on this button 
at this stage will start or resume the sound playing.

As a sound or video is playing, the Status Bar under the Menu Bar will reflect the position of that 
sound or video - furthermore, you can use the bar that travels across the Status Bar to set the video 
or sound position, by holding down the mouse button on that bar, dragging the bar to a new position, 
and releasing the bar.

Controlling Video Size

Use the Options dialog box to alter the size at which videos can be played at. If you are having 
trouble playing videos on your systems, you may prefer to play them at the smaller size - this often 
improves quality. However, you may have a very fast system, in which case you can try playing the 
videos at a larger size.

You will also find a small 'Size' button at the bottom right hand side of every video. This can also be 
used to set the size of the video.



Toolbar
The Toolbar sits across the top of the screen, and is used to control your journey through the 
multimedia experience, as well as set many of the options along the way.

You can hide or show the Toolbar using options found within the 'Options' dialog box, which appears 
when you select the 'Options' button on the Toolbar, or the 'Options' command, from the 'Tools' menu.

Below is an explanation of each of the Toolbar buttons.

Options: Selecting this button invokes the Options dialog box that allows you to change text and text 
background colour, modify the look of the screen, modify picture options, and choose whether to 
automatically play sound or movies as you move to a page.

Search: Selecting the Search button invokes the Search dialog box that allows you to search for a 
wide range of options including words, topics, user-added notes, highlighted text, video, graphs, 
tables and/or sound.

Hide/Show Text: Clicking on this button hides the text currently displayed in a text window on the 
screen. Once you have done this, this button changes to Show Text, which then allows you to re-
display the text on the screen.

First Page: Clicking on this button will return you to the first page of the Section.

Back: Clicking on this button takes you back one page. (Please note that the page number is always 
shown at the top of the text box window as well as in the Status Bar below the Menu Bar.)

Next Page: Clicking on this button moves you forward one page at a time.

End: Clicking on this button takes you to the last page of the Section.

Contents: Clicking on this button takes you back to the Contents screen (thus closing down this 
Section) or keeps you on this page and displays the alternative Contents Rollup screen.

Print: Clicking on this button displays the Print dialog box. Printing capabilities are very extensive and
are discussed in the Printing section.

Add Note: The Add Note button allows you to add your own text to each and any page of this CD-
ROM. Click on this button to display a pop-up window and simply key in your text.

Play/Pause Sound/Video: This button which currently displays Play Video can actually display four 
different options depending upon what is on the page at the time. As well as Play Video, it can 
display Pause Video, Play Sound, and Pause Sound. If this button is greyed out, it means that there 
is no sound or video associated with this page.

Tours: Clicking on this button provides access to the Tours dialog box. From this dialog box, you can 
select a tour (which is a guided screen show based on a certain theme).



Slide Shows
At any stage, you can select the 'Run as Slide Show' command, from the 'Controls' menu, to run the 
product as a slide show. In other words, there is no need to turn the pages manually.

The slide show will play from the current page to the end of the current section. The way it works is 
quite simple. If there is a sound, movie, or animation on a page, that sound, movie or animation is 
played till it finishes, and the program moves to the next page automatically. If there is no sound, 
movie, or animation associated with a page, then that page is displayed for 10 seconds before 
moving on.

You can cancel a slide show by pressing the 'Esc' key.



Word Search
This dialog box appears when you select the 'Word' button, from the Search Dialog Box. This dialog 
box is used to search for a word or phrase. Quite simply, you enter the 'Text to Search For', the area 
to search for this text, and click on OK. This dialog box will then disappear, and you will return to the 
'Search Dialog Box', where all pages that contain the text you searched for will be listed.

Below this picture we cover all these options in detail.

Text to Search For

In this text box, enter the text you would like to search for.

Search Pages

If you check this option, the main text from every page will be searched for the word or phrase.

Search Page Names

If you check this option, the title of every page in this book will be searched for the word or phrase.

Use Phonetic Word Matching

This option can only be used to search page names, not entire pages in the CD. When you select 
this option, the program uses a kind of fuzzy search for the word you are after. A close match, rather 
than an exact match, may be found. For example, if you enter the word 'Snike' to search for, you may
end up with all page names that contain the word 'Snake', as well as all pages that contain the word 
'Skink'. This is a great way to locate words of which you are not sure of the spelling.

For example, the entries 'Larista', 'Larissta' and 'Larest' will all locate the name 'Lerista'. This search 
takes a little longer than other searches.

OK

When you have entered the text you would like to search for, and have made your selections in the 
options above this button, click on OK to begin the search.



Tours
The Tours button, at the top right hand corner of the Toolbar, allows you to select a 'tour' - a self-
running excursion - to discover facts and animals on a wide range of topics.

To select a tour, click on the tour that interests you (the scroll bar on the right hand side of the dialog 
box may reveal more tours you may go on). When a tour is selected, select the Run Selected Tour 
button to start the tour.

Once the tour starts, the Status Bar turns red, and a small icon travels across this bar indicating how 
long each page is displayed for. To stop a tour, press Esc. In fact, a tour will be halted whenever you 
select a menu command, or toolbar button.



Custom Searching
This dialog box is available by selecting the Custom... button from the Search dialog box.

In this dialog box, you can make selection that determine the type of snake you are looking for. Using
the list boxes provided, you can make selections as you wish:

Abundance

Here, you can select an abundance category for the frog that you would like to search for.

Status

Here, you can select an status category for the frog that you would like to search for. For example, 
you may wish to search for all extinct snakes.

In the same

Using the 'In the same' and the 'as the' list boxes, you can search for all frogs, for example, in the 
same family as the Tree Frog, or the same Family as the Giant Frog. When the 'In the Same' list box 
is set to 'Class', or the 'as the' list box is set to ' - Does Not Matter' than this option will be skipped 
when the search begins.

Distribution Options

Above this option, you will see a sample distribution map. You can draw a rectangle on this map, by 
holding down the mouse button and dragging when the mouse is over the map. The idea is that you 
draw a rectangle encompassing the area in which you would like to locate an animal - for example, 
over New South Wales. When you have done this, you can select the option 'Search Through 
Distribution Maps' option from the Distribution Options.

Maps will then be searched as a part of the search. Keep in mind that each map has to opened and 
checked, which is not as fast a process as checking text files - this search may take a while.

Search

Click on this button to start searching for the snakes that meet your specifications. The frogs found 
will be listed in the Search dialog box, where you can move directly to that page at any stage.



Tour Creation
Using the 'Tour Maker' command in the 'Interaction' menu, you can create your own self-guided tours
through the product - for either your own use, or for the use of students, peers, etc.

A 'tour' that you create will end up like the sample tours visible from the Tours dialog box, which 
appears when you select the Tour button from the toolbar. In fact, assuming that you installed this 
product to hard disk (using the Fast Run - Slow Install method of installation), you can save your own
tours to hard disk, and have these appear automatically in the Tours dialog box.

This dialog box is a rollup - note the two buttons at the top right-hand corner of the dialog 
box. The right-hand button will allow you to alternately rool up, and unroll the dialog box - 
shrinking it, but not removing it from the screen. The button just to the left of this button, with
the cross in it, will hide this dialog box.

Tour Name

At the top of the dialog box, you give your tour a name, as it will appear in the tours dialog box and in
the status bas as the tour is running. This can be any length (although only around 100 characters or
so will ever be visible in the Tours dialog box).

Tour Picture

This is the picture that will represent your tour in the Tours dialog box. You can select any image 
listed in the 'Picture List' list, just to the right of this picture.

Tour List

This is the list of pages currently in the tour. It is from this list that you will be able to add and remove 
pages from your tour.

Sounds List and Load Sound Button

For every page in the tour, you can add your own sound. This sound can be any sound you desire - it
provides a way for you to provide your own background music, or perhaps verbal annotation over 
any image as it is displayed. When you load a sound, using the Loasd Sound button below this list, 
you can load a sound anywhere from disk - but remember that when you play back this tour, the tour 
will look in the directory in which the sound was loaded from originally to play that sound.

Delete Page and Add Page Buttons

These buttons are used to add and remove pages from the Tour List. The Delete Page button will 
remove the currently selected page from the list. The Add Page button will add the currently 
displayed page to the Tour List.

Save Tour

This button allows you to save your tour to disk. Only save the tour in the directory that is suggested 
- tours not in the correct directory (the directory in which this CD is installed) will not be able to be 
played.



Load Tour

This button loads an already existing tour from disk for editing.

New Tour

This button clears all lists and pictures ready to create a new tour.

A tour file on disk (with a tur extension) is transportable (except for sounds). This means that you can
copy one tur files from one machine to another, and play that tour on the new machine.
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